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Introduction
Welcome to RapidWeaver
RapidWeaver is an easy to use, yet powerful website-building application allowing anyone 
to create and publish professional looking websites in minutes.

RapidWeaver offers:

• Theme based site creation

• Fully featured blogging

• Photo & movie album creation

• Flash Slideshow creation

• One-click smart publishing

Advanced features:

• Unlimited submenu system

• Live PHP rendering

• XHTML and CSS based themes

• Semantically correct XHTML output

• Powerful plugin architecture

And much, much more...
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Installing RapidWeaver
We’ll have you up and running in no time
As with all good mac apps, installation is a snap. It’s a simple case of drag and drop. Fol-
low the instructions bellow to install RapidWeaver.

Downloading and Installing RapidWeaver
1. Visit the Realmac Software website, and locate the Download button. Click the Down-

load link to start the download process.

2. Once the file has finished downloading, double-click the downloaded file to extract Ra-
pidWeaver to the same location you downloaded the ZIP file to.

3. Drag RapidWeaver.app to your ~/Applications folder

4. Once this is done, you can trash and delete the downloaded ZIP file.

5. Launch RapidWeaver by double-clicking the RapidWeaver icon located in your Applica-
tions folder.
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Registering RapidWeaver
Entering your Serial Number

After you've installed RapidWeaver, it will run in demo mode until it’s registered. Demo 
mode works exactly like the registered version, but you can only add three pages to your 
website project. For unlimited pages per project, you’ll need to register your copy.

When you launch RapidWeaver you will be presented with a registration dialog containing 
the following options: “Buy Now!”, “Unlock” and “Use Demo”.

Enter the serial number (that begins RW3SN) you received when you purchased the soft-
ware into the field next to the Unlock button. You’ll need to be connected to the internet. 
Once you're sure the license code has been entered correctly, press the Unlock button, 
and then click ‘Activate’. Within a couple of seconds RapidWeaver will acknowledge that 
you’ve activated your copy, and you’re set to go.

If you encounter any issues with registration, please refer to the ‘Where Can I Get Help’ 
section.

RapidWeaver is now fully registered and the 3 page restriction has been removed.
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Quick-start Tutorial
Let’s get started
This quick-start tutorial will guide you through the basics of of creating and publishing your 
very own website. Before you start make sure you have the latest version of RapidWeaver 
installed.

Launch RapaidWeaver and create a brand new document if RapidWeaver hasn’t already 
done so for you.

Adding a page
• Click the + button in the bottom left-hand corner of the main window. The Page Type list 

will appear.

• Pick a Styled Text page from the Page Type list. The new page will be added to the Web 
Pages List on the left hand side of the Main Window as "Untitled Page 1".

• Double-click the page's name in the Web Pages List and give it a new name, such as 
"Home" for example. This name will be used in the site’s navigation menu.

• RapidWeaver will now have switched itself to “Edit” mode. Type some content in the Edit-
ing area and style it using the Format menu.
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• When you're ready, press the Preview button located at the top of the main window to 
render your newly-created page using the default theme.

Organizing Your Website
Once you have added two or more pages to your project, you can or-
ganize them in the order you'd like them to be listed in your navigation 
menu by dragging them into position in the Web Pages List.

If you wish to nest one page under another, you can drag-and-drop 
the page to be nested on top of the page under which is should be 
nested. This creates sub-pages, and serves as a handy way of organ-
izing similar pages under a single heading. If, for example, you have 
several different styled text pages that relate to each other, you might 
want to nest them under "Home" parent page, as shown to the right.

Choosing a Theme
To apply a theme to your website, open the Themes drawer by clicking 
on the Themes button found at the bottom right corner of main win-
dow. The Themes drawer will open from the bottom of the main win-
dow, displaying a scrollable row of thumbnails of the available themes. 
Scroll left and right through the list of available themes and select the 
theme you want to use by clicking on it.

Whilst You can add unlimited levels of sub-pages, but from a usability point of view we 
recommend that you add no more than two sub-levels, as it can become confusing for 
people visiting your site.

Publishing your Website
To publish your site, click the Publish button at the bottom right corner of the 
Main Window.

You can then choose to publish your site to an FTP or .Mac server. Enter the the publish-
ing credentials for your FTP or .Mac account and click the Login button.

Upload times can vary greatly depending on the number and type of pages and the speed 
of your Internet connection. When you have successfully uploaded your website, you can 
then view it using a web browser. Additional information about publishing can be found in 
the RapidWeaver Publishing section.
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RapidWeaver Overview
Main Window
RapidWeaver enjoys one of easiest and most flexible interfaces to learn and use.

RapidWeaver's main window is used to build your website, and consists of a Web Pages 
List pane on the left and a Page Content pane on the right of the window.

Manage the pages of your website by using the add (+) and delete (-) buttons, located at 
the bottom of the Web Pages List pane. The add (+) button opens the Page Type Selec-
tion pane. Simply double-click the page type you want to add and it will appear in the Web 
Pages List below the currently-selected page.

Once the new page has been added, you can drag it to another position in the list as de-
scribed in the Getting Started section. You can also delete a page that is no longer needed 
by selecting the intended page in the list and clicking the delete (-) button at the bottom of 
the list.

Edit & Preview
To edit and preview a page, click on the desired page in the Web Pages List pane to load it 
into the Page Content pane, where you may edit and preview its content. You can switch 
between Edit and Preview mode by clicking the “Edit” or “Preview” tabs located at the top 
of the Page Content pane. You can also press Command-R to toggle between the Edit and 
Preview modes.
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View Source
To enter Code view mode, click the "Code" tab at the top of the Page Content pane, or 
type Command-Alt-U from the keyboard. The upper portion of the view shows the HTML 
code as rendered by RapidWeaver. Any errors and warnings are displayed in the lower 
portion of the screen for your inspection and review. Click the "Display tidied code" box to 
see how RapidWeaver will tidy up your code. The code view is not editable.

Contextual / Action Menu
To access a page's contextual menu, either right-click/control-click on a page in the Web 
Pages List or click on the Action button below the Web Page list view.
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Theme Browser
One of the core design concepts of RapidWeaver is the use of themes. Themes are web-
site page templates that include the basic layout and architecture of each page. In most 
cases, users will typically select just one theme and implement it throughout their website. 
However, RapidWeaver also allows you to apply themes on a page-by-page basis using 
the Page Inspector.

Theme Selection
Selecting which theme you want to use is simple. Click the Themes Drawer button at the 
bottom right corner of the main window to expose the themes drawer.

Scroll left or right through the theme thumbnails and click on the one you want to use. The 
selected theme will be applied to your web pages.

Themes typically have several variations that can be applied in order to easily change a 
particular aspect of the site's layout or design. Variations such as sidebar placement, page 
styles, text color, font face, page width, page header images, and background color are all 
potential options. A number of themes also are now "pluggable" with pre-created header 
images and font styles, making it easier to customise the theme. Variations are accessible 
via the Theme Inspector, selectable from the Window menu or by typing Command-3 from 
the keyboard, and can be applied just to the current page, or to all future pages.

By right-clicking/control-clicking on a theme in the Themes Drawer, you can expose a 
handy contextual menu.

You may use the contextual menu to duplicate a theme (for subsequent customization), 
show its contents (for in-place editing), or to open the Theme Inspector. If the selected 
theme is an add-in theme located in the RapidWeaver Application Support folder, you will 
also see an option to delete the selected theme.
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Page Inspector
The Page Inspector provides an easy-to-use method to edit and modify page attributes 
such as file names, image formats, Meta tags, sidebar content and even page-specific 
custom CSS or Javascript code. It's an incredibly powerful way to customise selected 
pages.

To access the Page Inspector select "Page Inspector" from the Action Menu, or select it 
from the Window menu, or press Command-I from the keyboard. This brings up the Page 
Inspector palette.

The Page Inspector is organized into five sections:

1.General Settings: Edit the page's title, file and folder names, display options, 
image format and page output.

2.Page Sidebar: Edit sidebar title (if used), and add content to the page's side-
bar.

3.Page Header: Allows you to add page assets and Meta tags, or apply the cur-
rent page's properties to other pages. You are also able to add custom Javas-
cript or CSS to the selected page, or insert code above the <!DOCTYPE> tag.

4.Theme Styles: Customise the design of the page.

5.Plugin Settings: Any plugin options are shown in this tab - for example, the 
Blog setup, Contact Form, and Photo Album setup are all controlled from within 
this tab.

These options will be applied to the page you have selected in the Pages List. To apply 
these options to other pages in your project, use the "Apply Properties to All Pages" option 
found on the Advanced tab (see below.) You may also pre-set many of these options in the 
Site Setup for pages you subsequently add to your project.

Tab: General Settings
When you first open the Page Inspector, you are brought to the "General" tab view. Use 
this view to set the selected page's file and folder names, display options (including 
whether or not to show the page in the navigation menu), image format and page output, 
and title, slogan and copyright information. You may also specify encoding and set output 
options.

To understand each of the options found on the Info pane, refer to the brief descriptions 
that follow:

• Enabled: When checked (default), this page will be published or exported as part of your 
website. Unchecking this box will prevent the page from being published or exported.

• Show in menu: Left unchecked (default), this page will be listed in the navigation menu. 
Checking this box will prevent the page from being listed in the navigation menu.
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• Open in new Window: Left unchecked (deafult), this page will load in the current 
browser window when selected in the navigation menu. By checking this box, the page 
will open in a new browser window when clicked in the navigation menu.

• Page Title: Sets the name of the page in the navigation menu.

• Browser Title: Sets the title used in the browser title bar at the top of the browser win-
dow.

• Folder: Sets the folder name for the place where the current page is stored. If you want 
your page to be in the root directory of your site, set this to "/" without the quotes. Other-
wise set the folder name as desired. You can also set multiple pages to be in the same 
folder, simply, by using a "/" and the name of the folder. For example "/software" .

• Filename: Sets the file name and extension for the selected page, such as "photos.html" 
or "downloads.php". The home page will always be "index.html" (unless you have forced 
set a different filename extension in Site Setup.

• Image Format: When you manually add images to your site, RapidWeaver will convert 
them into your chosen format: Original, JPEG or PNG. Specifying “Original” will cause 
RapidWeaver to use the original file’s format. If you select JPEG, you can also set the 
compression quality. Note that if you wish to use transparent GIF images on a page, you 
must choose ‘Original’ for the format, otherwise transparencies will be lost in conversion.

• Encoding: Choose how you want the browser to interpret your code. Choose between 
Western (ISO Latin 1), Unicode (UTF-8) and Japanese (Shift-JS).

• Output: When adding HTML to an HTML page or a Styled Text page, it's easy to make 
mistakes. Wouldn't it be nice if there were a simple way to fix these mistakes automati-
cally and tidy up sloppy editing into nicely laid-out markup? Well, now there is! By select-
ing "Tidied" or "Optimized" from the Page Output popup menu, RapidWeaver can fix 
common HTML mistakes for you. (See Graph)

• Title: Left unchecked (default), the page will use the site title set in Site Setup. By 
checking this box and typing a different title, the default site title of this page will be re-
placed with the one you provide here.

• Slogan: Left unchecked (default), the page will use the site slogan set in Site Setup. By 
checking this box and typing a different slogan, the default site slogan of this page will be 
replaced with the one you provide here.

• Copyright: Left unchecked (default), the page will use the site copyright set in Site 
Setup. By checking this box and typing a different copyright, the default site copyright of 
this page will be replaced with the one you provide here.

• Apple to All Pages: This allows you to apply the current settings for the selected page 
to all other pages.

RapidWeaver 3.6.2 Manual v1.0 (2nd August 2007)
 Page 12



Tab: Page Sidebar
Use the Sidebar pane of the Page Inspector to add content to the side section of 
your website using styled text or HTML. For example, you may want to add web 

badges, include a search tool for your website, or indicate your chat status. You can place 
virtually anything in the sidebar to enhance a single page or your entire site.

The Sidebar pane of the Page Inspector consists of two areas, the Sidebar Title field and 
the Sidebar Content box. To add an optional title to your website's sidebar, type the title 
into the Sidebar Title field. To add Styled Text, select Styled Text from the Setup menu, or 
if you’d rather enter pure HTML code select HTML from the Setup menu.

You can now add links via the RapidWeaver links sheet by clicking the [+] button at the 
bottom of a styled-text sidebar. The [-] button removes links.

Tab: Page Header
This Advanced pane of the Page Inspector includes many powerful tools, includ-
ing:

•  Meta Tags: Used to create Meta tags for your 
pages so search engines can find them. (See be-
low for examples)

•  Header: Add custom code to the header area of 
your site.

•  CSS: If you want to add Custom CSS code on a 
page by page basis, then you can simply drop it 
into the Custom CSS box.

•  Javascript: You can add Custom Javascript, just 
like you can add Custom CSS, to individual 
pages via this tab.

•  Prefix: Any code here will appear at the very top 
of the page, perfect for start php sessions.

•  Assets: Any files or URL’s added here are then 
accessible via the Add Link button within Rapid-
Weaver.

Meta Tags Explained
If you'd like to let search engines to easily know the content of your website, then use 
Meta tags. Listed below are a few commonly-used Meta tags. You can customise the con-
tent to match your site.
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To add a Meta tag to a page, click the (+) button. On the selected line, double-click the 
area immediately below the "Name" heading. In the selected text area, type one of Meta 
tag names listed above (without quotes). Once you've entered the Meta tag name, press 
the tab key or double-click the area to the right of the Meta tag name you created and type 
the Meta tag content, (again without quotes). Keywords should be separated by commas.

Name

keywords Apple, Software, RapidWeaver

description Software for Mac OS X

copyright Copyright 2007 Realmac Software

robots all

To add a Meta tag to a page, click the [+] button. On the selected line, double-click the 
area immediately below the "Name" heading. In the selected text area, type one of Meta 
tag names listed above (without quotes). Once you've entered the Meta tag name, press 
the tab key or double-click the area to the right of the Meta tag name you created and type 
the Meta tag content, (again without quotes). Keywords should be separated by commas.

•  Expires In: To specify an expiry date for this page, click "Expires in" checkbox and se-
lect the timeframe (minutes, hours, days, weeks, or months) using the popup timeframe 
menu. Lastly, type a value in the number field. The page should be considered expired 
after the specified amount of time has elapsed following the page's publication. Web ro-
bots may delete expired documents from a search engine, or schedule a revisit. If the 
"Expires in" box is left unchecked, your page will not include an expiry date.

•  Credit RapidWeaver: To identify your website as one that was created by Rapid-
Weaver, select the "Credit RapidWeaver" checkbox. If this option is selected, Rapid-
Weaver will add the "Generator" Meta tag to the head section of your site. It lets brows-
ers and visitors know that your site was made with RapidWeaver. This does not add a 
visible credit to RapidWeaver on your webpage!
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• Custom CSS: By adding CSS styles code to the Custom CSS box, you can over-ride 
the look and feel of a page, or add additional styles and customise how your page looks. 
Simply add the CSS exactly as you would in any other CSS editor, then link to those 
styles with standard HTML.

• Custom Javascript: Works just like the Custom CSS, just add your own Javascript and 
link to it in the normal way.

• Prefix: Any custom code entered into the "Page Prefix" box will be placed before the 
<!DOCTYPE> tag of the page when rendered. For example, you may need to initiate a 
PHP session so that certain variables (such as names, passwords, email addresses, 
etc.) will be passed between pages. Because a PHP session has to be started before 
any other document information is loaded, you would add the PHP code to the Page 
Prefix.

• Use XML Declaration: Check this box if an XML declaration should be used for the page 

Note: Some servers and browsers have problems with the XML encoding declaration. If 
you are experiencing problems, try switching off the XML encoding declaration. This 
is the declaration RapidWeaver uses:

<?xml version="1.0" encoding="iso-8859-1"?>
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Tab: Theme Styles
The pane is used to set theme styles such as site width, font, color schemes and 
sidebar alignment.

It is worth noting that not all themes - and especially older themes created before version 
3.2 - will include variations. Variations are built into a theme by the theme’s designer, so 
some themes may have more variations while others may have fewer or, perhaps, none at 
all.

Depending on the theme being used, available variations will  be listed in the Theme In-
spector’s Variations list, each preceded by a black triangle. Clicking the triangle will ex-
pand the variation group, and allow you to choose a variation for that particular option.

For example, clicking the triangle preceding “Sidebar” presents the options of “Right”, 
“Left” or “Hide”. By clicking the appropriate radio button, RapidWeaver will position (or re-
move) the sidebar as you require.

Tab: Plugin Settings
This pane will change to reflect the page you have highlighted. Please refer to 
the Page styles section to find out more.
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Site Setup
The Site Setup palette in RapidWeaver allows you to edit and modify site-wide attributes 
such as the logo & favicon, image formats, publishing options and much more. 

When starting a new site, the site setup should be one of the first things you configure.

To access the Site Setup, select “Site Setup” from the “Window” menu or press Command-
1 from the keyboard. This opens the Site Setup floating palette. At the top of the palette, 
you’ll find four tabs:

The Site Setup Inspector is organized into five sections:

• Site Setup: Customise the site title, slogan and copyright and add an email address, 
logo and favicon.

• Page Template: Set file and image options, add default sidebar content and meta tags.

• Preview: Choose a default preview browser and preview path.

• Publishing: Set the base URL as well as publishing and exporting options.

Tab: Site Setup
The site setup  section defines page defaults such as the title, slogan, copyright 
and email address. You can also specify these attributes uniquely on each page 
using the Page Inspector.

You can also specify the index page's file name (typically 'index.html' or ‘index.php’), en-
able a breadcrumb trail option across the site, so visitors to your site know exactly where 
they are and add a logo and favicon.

To add a logo or favicon, just check the tick box and drag the desired file into the box. Al-
ternatively, click the "Choose..." button and select a file from you computer.

Tab: Page Template
The options under the "Page Template" tab will affect each page as it is cre-
ated. For example if you want each page to have an extension of .php instead 
of .html as you add pages to your website project, you can set the extension 

here. Each time you add a new page, it will have an extension of .php.

• Extension: Allows you to specify the extension of each page. Some common extensions 
are .html, .htm and .php.

• Output: When editing HTML, it's easy to make mistakes. Wouldn't it be nice if there were 
a simple way to fix these mistakes automatically and tidy up sloppy editing into nicely 
laid-out markup? Well, now there is! Simply select one of the following three options from 
the "Output" drop down list and let RapidWeaver do the work for you.

• XML Declaration: Check this box if an XML declaration should be used for the page.

• Export Image as: When you manually add images to your site, RapidWeaver will con-
vert them into your chosen format: original, JPEG or PNG. If you select JPEG, you can 
also set the compression quality.
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• Sidebar: Allows you to automatically add the same text or HTML content in the sidebar 
of every newly-created page. You can alter the sidebar content of any page individually 
after this using the Page Inspector.

• Meta Tags: If you'd like to let search engines to easily know the content of your website, 
then use Meta tags. Listed below are a few commonly-used Meta tags. You can custom-
ise the content to match your site.

• Expires In (Meta tag) To specify an expiry date for this page, click "Expires in" checkbox 
and select the timeframe (minutes, hours, days, weeks, or months) using the popup ti-
meframe menu. Lastly, type a value in the number field. The page should be considered 
expired after the specified amount of time has elapsed following the page's publication. 
Web robots may delete expired documents from a search engine, or schedule a revisit. If 
the "Expires in" box is left unchecked, your page will not include an expiry date.

• Credit RapidWeaver (Meta tag) To identify your website as one that was created by 
RapidWeaver, select the "Credit RapidWeaver" checkbox. If this option is selected, Ra-
pidWeaver will add the "Generator" Meta tag to the head section of your site. It lets 
browsers and visitors know that your site was made with RapidWeaver.

NOTE: Options selected in the Page Template will be applied only to new pages as they 
are added, and will not affect existing pages in your website project. You can alter existing 
pages' settings on a per-page basis, or apply changes to page properties site-wide, by us-
ing the Page Inspector.

Tab: Preview
The Preview tab allows you to specify the default browser to use when previewing your 
site after it has been exported to the folder/path you specify in the Export Path option.

• Preview In Browser: Automatically preview your exported RapidWeaver site in any 
browser. Enable this feature by checking the "Preview after export" box. Select your 
browser of choice from the drop down list. The next time you export your site you will get 
an instant preview in the specified browser.

• Preview in RapidWeaver: Selecting the "Preview in place" checkbox will allow you to 
browse your site from within RapidWeaver using the browser you selected in the "Pre-
view in Browser" option.

• For the "Preview in place" feature to work (live browsing), specify a destination folder to 
which RapidWeaver can store all of the website's pages. You may either type an explicit 
path, or use the "Browse" button to set a destination folder.

• Process PHP Files: This option allows you to save time by removing the need to export 
and upload your PHP-based webpages to your server. Now you can get instant previews 
of your PHP code directly inside RapidWeaver. 

Tab: Publishing
The choices found under the Publishing tab allow you to set options when pub-
lishing your website or exporting it to a local directory on your Mac .
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• Website Address: Enter the Site URL for your website here, for example: 
http://www.realmacsoftware.com/ The Site URL is used to create RSS feeds for you blog 
and when you use the "Relative To Base URL" option (see below for more information).

• When Publishing: Selected by default, the "Enable smart publishing" option can save 
considerable time when publishing updates to your website. RapidWeaver will compare 
each file on your server with its original source file on your local drive. Files that have not 
changed since their previous publication will not be transferred again. Unchecking this 
box will cause RapidWeaver to re-upload each page and every file each time you update 
your website.

• If your site includes photo albums, movies or any other large files. the amount of time 
needed to perform site updates can be dramatically reduced! However, if you need to 
reset your website so that all pages and files are re-published, you may click the “Clear 
Publishing Cache” button.

• When Exporting: To prevent RaidWeaver from deleting the export folder when exporting 
your website, click the "Don't delete current folder" checkbox. When selected, Rapid-
Weaver will only overwrite any existing files having the same names when you export 
your site. Left unchecked, RapidWeaver will delete the existing folder and its contents 
before exporting your site.

• Clear a page's "Changed" flag when: Specify when you want RapidWeaver to clear 
each pages' changed state, either after being Exported or Published or both.

• Common File Links Are: Each page in RapidWeaver uses certain page elements to 
construct and format the page, including various graphic elements used in the theme, 
CSS elements, javascript code, and more. If the "Consolidate common files" checkbox is 
unchecked, then for every page you add to your website, these elements are duplicated 
in each page's "files" folder whenever you publish. This makes your website larger and 
may affect your upload times.

When using the "Consolidate common files" checkbox, you may specify how common files 
should be accessed from within the pages of your website by using the "Relative to..." 
popup menu. 

Outlined below are the different ways RW will link to files. if you are unsure which option to 
use, we suggest leaving it on the default setting "Relative to Page".

Relative to Page 

../rw_common/themes/blog/styles.css 

Relative to DOCROOT 

/rw_common/themes/chosentheme/styles.css 

Relative to Base URL - Note that you need to ensure you’ve set up the Base URL!

http://www.your_server.com/rw_common/themes/the_theme/styles.css
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Media Inspector
The Media Inspector enables you to edit and modify the dimensions and attributes of im-
ages used in Styled-Text pages, Blog pages and third-party page types that support styled 
text. You can even flip and rotate your images directly within RapidWeaver.

Access the Media Inspector by double-clicking an image you have placed in your Styled-
Text or Blog page, or by selecting it from the Window menu. The options available in the 
Media Inspector are summarised in the following table. 

Option

Filename Sets the name of the actual file (e.g., "myimage.jpg").

Alt tag Sets the alt tag of the image, which is displayed while the 
image is loading and when you hover your cursor over the 
image.

Scale Scales the highlighted image using percent.

Width & Height Un-checking the "Scale Image" check box allows you to set 
the "Width" and "Height" values independently.

Rotation Allows you to rotate the selected image through 360º.

Crop Constrains image's window to its scaled dimensions when 
rotating image; uncheck this box to leave image un-
cropped.

Flip Flips the selected image horizontally and vertically.

Shadow Check the Shadow box for RW to render a shadow for the 
image; specify the shadow's offset and blurring by editing 
the respective values, and choose the shadow's colour.

Border Check the Border box to add a border around your image 
and specify its width and colour.

Fill Colour Specify the fill colour if necessary; used when an image is 
rotated or when a drop-shadow is added.

Because image source files can be quite large (some measuring several Megabytes), they 
can dramatically increase the size of your RapidWeaver project file. It is generally recom-
mended that large files be down-sized to the approximate size to be used in your website 
whenever possible, and adjust the final size and orientation using the Media Inspector.
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Snippets
This feature is a new addition to RapidWeaver 3.6. It allows you to store snippets of code 
or text.

To open the snippets window go the “View” menu and select “Show Snippets” or use the 
keyboard shortcut, command-5.

View Menu > Show Snippets

To add a snippet press the plus button located at the bottom left hand corner of the Snip-
pets Window.

To use a snippet, drag it into any styled or html text area in your website.

Snippets can also be shared with others, via email, the web or the Addons section on the 
Realmac Software Website. To share them you’ll need to locate them - RapidWeaver 
stores them here:

~/Library/Application Support/RapidWeaver/Snippets/

Alternatively you can simply choose to reveal them from the Snippets window in Rapid-
Weaver itself (Cmd + 5).
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Page Types
What are page types?
Page Types are the various kinds of pages you can you can use to create your website in 
RapidWeaver. These include pages for blogging, adding photos, movies, text, HTML and 
more.

RapidWeaver includes an assortment of different page types that you use to build your 
website. Here is a summary of them. To learn more about any particular page type, click its 
name.

Page Types

Blog Join the latest Internet trend of blogging with this easy way 
to record personal events, thoughts, ideas and more.

Contact Form The Contact form creates a submission page that lets visi-
tors to your website send you a message via an easy-to-
use form.

File Sharing Share files, photos and documents with friends, family and 
co-workers.

HTML Take advantage of RapidWeaver's power features and use 
HTML, XHTML or PHP to create virtually anything.

iFrame Display any external website within your own RW-styled 
page.

Movie Album Allows you to share a gallery of QuickTime movies with 
visitors.

Offsite Page Use this page to redirect the user to an external URL such 
as a free web board, a friend's website, an affiliate, or any 
other site from your site's navigation menu.

Photo Album Share your photos with friends, family and co-workers us-
ing either a Gallery or a Flash Slideshow. Photos can either 
be dragged and dropped into a user-created album within 
RW, or you can use previously created iPhoto albums.

QuickTime Add a QuickTime movie to your site.

Styled Text Create your page content in a what-you-see-is-what-you-
get format. You have the ability to set font styles, change 
colors, drop-in images, movies and other files.
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Blog
The Blog page type permits you to manage a collection of blog entries; recording personal 
events, thoughts, ideas and more. You may also add audio or video files to a blog entry to 
create Podcasts. All of these can be syndicated using RSS feeds.

Adding an Entry
To add a new entry to your Blog, just click the [+] button located just below your blog en-
tries list. The time and date will automatically be entered in the time-and-date stamp field 
according to the format specified in the Blog Page -> Setup area in the Page Inspector 
(described later in this section). You may change the time or date by typing it directly into 
the time-and-date stamp field, or set it to the current time and date by clicking the Clock 
button. Give your blog entry a title and then type your blog's message in the Main Entry 
box, located at the bottom of the page. The content area of the Main Entry area supports 
all of the features and functionality of a styled text page, allowing you to add styled text, 
links, HTML, movies and images. You may also use the Page Assets to add links and files 
to your blog entry.

Smileys
In the blog entry you can use smileys just like in iChat. The Blog page style supports 8 dif-
ferent smiley emotions. For example, entering :-) in your blog, RapidWeaver will convert it 
into     

Listed below are the supported smileys:

Smiley

Smile :-)

Laugh :-D

Sad :-(

Wink ;-)

Gasp :-o

Embarrassed :-[

Angry :-|

Foot-in-mouth :-!

Tags and Categories
RapidWeaver now offers Tags and Categories for Blog entries. More can be read about 
them later in this section.

Permalinks
A Permalink is a permanent link to a specific blog entry so that visitors may return to it 
even if it has been archived and moved off of the main page. When enabled in the Gen-
eral tab of the Blog’s Setup area, RapidWeaver will automatically create a Permalink for 
each blog entry. If you'd like to create a custom Permalink for a specific blog entry, click 
the "Custom Permalink" checkbox and type in a unique word or phrase (e.g. "my_fir-
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st_blog") into the Permalink field. When RapidWeaver publishes your blog page, it will 
create a Permalink based on the word or phrase you've entered.

TIP: RapidWeaver will automatically append the file extension (.html or .php) de-
pending on what extension the page you’ve used in the page inspector.

Adding Podcasts
RapidWeaver allows you to easily add Podcasts to your blog entries. Podcasting is an 
evolving standard that allows audio or video files (most commonly in MP3 or MP4 formats) 
to be published online in a way that allows Podcast receiver programs - such as iTunes, 
Transistr, NewsFire and others - to automatically subscribe to them and download the files 

for playback at the listener's convenience.

When you add a Podcast to your blog entry by clicking the 
"Add Podcast..." button, RapidWeaver presents a Podcast 

pane that allows you to drag-and-drop your Podcast media-file into your blog entry. You 
can customise your iTunes tags, set custom RSS tags and even specify external multime-
dia files to be used for your Podcast if you choose not to use the Podcast dropbox.

Blog Settings
Before you can syndicate your blog or broadcast your Podcasts, you must first configure 
your blog to use RSS feeds, set your default Podcast tags and customise your blog page's 
options. Click Setup while you are in the "Edit" mode.

The Blog Setup area has six main tabs:

• General - Set Archiving, Permalink and Commenting options.

• Categories - Enable and create blog categories.

• RSS Feed - Configure the RSS feed for your Blog page.

• Date Format - Configure the format of your time and date of blog posts.

• Podcast - Set the default iTunes tags and Custom RSS Channel tags for your Podcasts.

• Ping - Enable weblog directory/tracking services to keep track of recent changes in your 
blog page.

When you first click the "Setup..." button, the pane will default to the "General" tab. Click 
the desired tab to expose the contents of its pane.

Tab: General
The top section of the General tab contains the archiving options for your blog in which 
you can customise the archiving behaviour, if used. By default, archiving is active. Dis-
abling it will cause RapidWeaver to keep all of your blog's posts on the same page, grow-
ing longer with each blog entry you add. If enabled, archiving will move all your old posts 
to separate pages, keeping only the current week's or month's posts on the main page, as 
selected in the "Archive by" popup menu. You can also set the minimum number of posts 
that must appear on the main blog page before older posts are archived, and whether or 
not to show gaps in your archived posts.
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The middle section of the General tab allows you to enable Permalinks in your blog and to 
set the Permalink’s link title. If you use summaries in your blog entries, you may choose 
whether the Permalink points to the summary rather than the blog entry itself by clicking 
the “Include Summary” checkbox. When published, the Permalink will point to the sum-
mary, which will include a “Read more...” link to the full blog entry. You may also change 
the “Read more...” link’s wording by typing a word or phrase of your own choosing. This 
will become the system-wide link phrase when used in summaries in your blog.

The bottom portion of the General tab allows you to enable Comments in your blog entries, 
allowing visitors to post feedback for your blog posts. To enable blog comments, you must 
first sign up with Haloscan, a free comment-tracking service for bloggers. Once you have 
an account, enter your Haloscan username into the “Username” field and enable comment 
feeds by clicking the “Enable” checkbox. If you want to change the name of the comment 
feed’s RSS link that appears in the sidebar, type it into the “RSS Link” field. Once com-
menting is enabled, you will see “Comments (0) | Trackback (0)” appear under each entry 
in your blog. As comments and trackbacks are added, the values in the parentheses will 
increase incrementally. By default a link labeled “Comments Feed” will appear in the side-
bar of your blog page. Visitors who click this link will be taken to your user account page 
on Haloscan, showing all of your visitor’s comments. You can prevent the link from appear-
ing in your sidebar by removing the text from the “RSS Link” field on the “General” tab.

TIP: You can manage your comments and the look of the pop-up-window by logging into 
the member’s area on Haloscan. Instructions on how to integrate commenting with Ha-
loscan can be found at Haloscan.com.

Tab: Categories
By default, categories are enabled in RapidWeaver allowing you to set a category or clas-
sification of your individual blog entries. If categories are not desired, you may disable 
them by unchecking the "Enable" checkbox. If enabled, you may also choose to display 
the number of blog entries in each category in the sidebar by clicking the "Show Post 
Count" checkbox.

You can create additional categories for your blog by clicking the (+) button at the bottom 
of the categories list and typing the name of the new category. To remove a category, click 
on its name and click the (-) button. You may also arrange the categories in the list by 
clicking and dragging a category into a new position.

At the bottom of the Categories pane, you’ll find a Separator field. RapidWeaver uses the 
characters in this field to delineate the various blog entry details such as the date, cate-
gory, and permalink elements (located below the blog entry’s title in your blog). The default 
separator is a ‘pipe’ delimiter (‘|’) with a space character before and after it for balance 
(e.g. ‘ | ‘), but you may use a different combination of characters if desired.

Tab: Tags

Tags could be considered Sub-Categories, describing more accurately a blog post’s con-
tent. To enter a tag for a post, simply click in the tab box above the entry, type the Tag you 
wish to add, and hit Enter. The tag will turn to a ‘Token’ field and be applied to the post if 
tags are enabled.
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Tab: RSS
Many major news organizations, community websites and personal weblogs offer head-
lines and article summaries in the form of news feeds, using a technology called RSS 
(Really Simple Syndication). RSS-aware programs, called news aggregators, can help you 
keep up with all your favourite weblogs by checking their RSS feeds and displaying new 
items from each of them. iTunes, Transistr, NewsFire are among the many popular news 
aggregators in widespread use.

So that RSS news aggregators (including Podcast receivers) can subscribe to your blog 
page, you must enable RSS feeds for your blog page. You may also configure your blog 
page so that it generates RSS entries only for the indvidual blog posts that appear on your 
main blog page, and not for any archived blog entries, by checking the box "Generate en-
tries for main page only".

You may specify how many words from each of your blog entries should be included in 
your RSS feed (from one to fifty words) by selecting the checkbox labelled "Summarise 
text in RSS Entries" at the bottom of the pane, and moving the slider left or right as 
needed. The number of words will be shown to the right of the slider. If your blog entries 
use summaries, the number of words included in any blog entry's RSS feed will be lesser 
of the length of the blog entry's summary or the number of words set here.

Tab: Advanced

Sub-tab: Date Format
You can customise the way the date and time are shown by selecting the "Date Format" 
tab in your Blog page's "Setup..." area.

On this pane, you can specify how the date and time are displayed, including separators. 
As you make changes to the settings, an example is displayed in the lower portion of the 
pane. To localize the language to that of the one being used by your Macintosh, click the 
“Localize language” checkbox.

Sub-tab: iTunes
You may create default values for your iTunes tags and any custom RSS channel tags 
used in your Podcasts. The values entered here will become the default tags for all of your 
Podcasts, but you may override these values in any Podcast if desired by using the iTunes 
Tags and the Custom RSS Tags tabs in the Add Podcast pane.

When you click the “Podcast” tab in your blog’s “Setup...” area, two sub-tabs will be visible: 
“iTunes Tags” and “Custom RSS Channel Tags”. The default view is the “iTunes Tags” sub-
tab pane.

To set the default iTunes tags to be added to your Podcasts, click the “Enable Custom 
iTunes Tags” checkbox and edit the fields on the Podcast: iTunes Tags pane.

If you wish to add default custom RSS Channel tags to your Podcasts, click the “Custom 
RSS Channel Tags” sub tab.

Use the Custom RSS Channel Tags sub-pane to add any tags not addressed using the 
iTunes Tags sub-pane, or to add any new Channel tags that may be added to iTunes in the 
future. As a rule, this should be unnecessary, but the ability to add custom RSS Channel 
tags remains available if needed.
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Sub-tab: Channel
If you wish to use Advanced RSS tags, you should enter them here.
Sub-tab: Ping
As blogs have come into widespread use across the Internet, blog referral and tracking 
services have come into being. Companies like Technorati, Postami, BlogPulse and Goo-
gle follow blogs and keep track of what's important in the blogosphere — which bloggers 
are commanding attention, what ideas are rising in prominence, and the speed at which 
these conversations are taking place.

You can configure your blog to ping these blog directory services every time your blog 
page is updated. To add a service to ping, click the (+) button, type the name of the service 
and the URL to its "ping" page (the page on the service that accepts pings) and click the 
"Ping the following blog directories" box. You can also send a ping immediately to any 
newly-added service by selecting its entry in the list and clicking the "Ping Now" button.

Sub-tab: Other

Movable Type Import - Allows you to point RapidWeaver to a Movable Type export file, 
and RapidWeaver will import the posts into the blog page.

Dynamic PHP Sidebar - If you’ve got a lot of tags and categories, this will save you plenty 
of time. By taking advantage of PHP Includes, the sidebar is dynamically added, and there 
is no need to export each page every time the tag cloud changes. For those with large tag 
clouds, this will like reduce publishing time dramatically. This feature requires a PHP-
compatible host. Due to .Mac not supporting PHP, this feature will not work with any 
site published to .Mac.

Contact Form
The Contact Form page type lets visitors send messages and attachments to you via an 
easy-to-use form. You may completely customise the page to your specific requirements, 
including the use of checkboxes, radio buttons, text fields, pop-up menus and more.

The Contact Form requires PHP to be installed on your server. If you are unsure whether 
your server supports PHP, contact your hosting company before attempting to use the 
Contact Form page type.

Warning: The Contact Form does not work on Apple's .Mac service, because .Mac does 
not support PHP at this time.

The Contact Form supports six different types of page elements:

Form Elements

Text Field Restricts visitors to typing a single line of text.

Text Area Allows visitors to type an unlimited amount of text.

Checkboxes Visitors select one or more the displayed options by click-
ing its box.
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Form Elements

Popup Menus Visitors make a single selection from a defined popup 
menu.

Radio Buttons Visitors make a single selection from a list of options.

Attachments Allows visitors to attach a file to the form. Only one at-
tachment is allowed per form.

Each element includes an option to make it a required item on the published form. If you 
require that visitors must complete any given page element before the form can be submit-
ted, click the element's "Required" checkbox. Unchecked elements on the form will not re-
quire visitors to complete them.

When visitors submit a completed Contact Form on your website, an email is sent to the 
address you've specified in the form's setup page, containing the content of the form:

Your Name: Support Ninjas

Your Email: support.ninjas@realmacsoftware.com

Message Subject: I like RapidWeaver! 

Message: RapidWeaver makes it easy to create great-looking websites!

Building a Contact Form Page
When you add a Contact Form page, its form field list is initially pre-configured with four 
elements:

Your Name: Text field in which visitors to your site can type their names. 

Your Email: Text field in which your visitors provide their email addresses. 

Subject: Text field in which visitors enter the 
title of their message. 

Message: Text area in which visitors type the 
body of their message to you.

To remove any of the existing elements, click 
on its name in the form field list and click the 
[-] button at the bottom of the list.

To add a new field item to the form field list, 
click the [+] button. Type a label for the new 
field's name and then select the desired field 
type. If the field must be completed by the visi-
tor before the form can be submitted, click the 
"Required" checkbox.

TIP: When typing the field name for a newly-
added element, use a delimiter like a colon (:) 
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or a hyphen (–) to separate the label from the content provided by your visitors. Without a 
delimiter, the label and the content will be linked together in the message you receive.

Once you have added all of the elements required for your Contact Form page, you can 
re-arrange their order by dragging each element to the desired position in the list.

Popup Menus and Radio Buttons
If your Contact Form includes either a Popup Menu or Radio Buttons element, you should 
create a list of selection values for each of them. By clicking on the name of the desired 
Popup Menu or Radio Buttons element in the form field list, the Popup/Radio Values list at 
the bottom of the Contact Form page becomes available.

To add the first selection value in the Popup/Radio Values list, click the [+] button below 
the list. The first line will be highlighted and the word "Name" will appear in it. Double click 
the line to select it and type the first selection value. Repeat as needed to add all selection 
values. To remove a selection value, select it in the list and then click the [–] button.

Contact Form Setup
After setting up your Contact Form page, click Setup to change the settings for the contact 
form.

The Page Inspector will open and bring up a window such as the one to the right:

Setup Items

Send To: Enter the email address you want the form’s contents to be 
sent to.

From Name: The form field you want to appear as the name of the per-
son the email was sent from.

From Email: The form field that will contain the email address of the 
person the form was submitted by

Subject: The form field that will appear as the subject in any re-
ceived any emails from the form.

Submit Button The word(s) that appear on the button used to submit the 
form (default: "Submit").

Reset Button The word(s) that appear on the button used to reset the 
form (default: "Reset").

In most instances, it will not be necessary to change the values on the "Form" pane, but if 
you make changes, remember to save them by clicking the OK button.
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Files Sharing
RapidWeaver includes a File Sharing page type that allows you to easily share files, URLs 
and documents with visitors to your website. You can either link to files on your Mac's hard 
drive, or to files located elsewhere on the Internet.

The upper area of the File Sharing page displays a Files List window to which you add 
your files and URLs. The lower portion of the page contains a Page Description field. To 
add descriptive text for your published page, type the text in the Page Description field.

The Files List window is a series of rows, one row for each file or URL you add. Each row 
is divided into four fields: “Title”, “Description”, “Source” and “Source Type”.

Sharing files
To add files to RapidWeaver's File Sharing page, you may either drag them from a location 
on your hard drive and drop them into the File Sharing page, or use the (+) button to navi-
gate to the file and select it. When you add a file to the list, its title will default to the file's 
actual name (as seen in the Mac's Finder). If you wish to use a different title for the file, 
double-click in the "Title" field to change it. If desired, you may also add a description 
about the file in the adjacent "Description" field. To change the list order of the files, you 
may click-and-drag the files to arrange them in the preferred order.

TIP: To save space and reduce transfer times, it is generally recommended that you com-
press most files using a compression utility like Mac OS X's built-in archiving feature. To 
create .zip archive file using Mac OS X's native archiving tool, simply Control-click the file 
you want to compress (or if you you have a two-button mouse, right-click the file in the 
Finder) and choose "Create Archive of FILE_NAME" from the File's contextual menu.

Sharing URLs
To add URLs to RapidWeaver's File Sharing page, click the (+) button to create a new en-
try in the list. Add a title and a description to the new entry and then change the "Source 
Type" dop-down list option to 'External URL'. Finally, double-click into the "Source" field 
and type the fully-resolved URL. As with files, you may arrange their order in the list by 
clicking and dragging them do the desired positions.

TIP: You can use the File Sharing page type to create a "Favorite Links" page on your 
website. Just use the "Sharing URLs" procedure to add your favorite links to the list and 
publish.

RapidWeaver 3.6.2 Manual v1.0 (2nd August 2007)
 Page 30



HTML
The HTML page type allows you to enter all manner of content by entering a variety of 
code types into the page’s edit mode.

If you want to create an HTML page that retains the theme of the other pages in your web-
site, leave the “Don’t apply theme” checkbox located below the HTML content area unse-
lected. As you add code, you should restrict it to whatever code you would normally place 
between the <BODY> and </BODY> tags of an HTML page.

The HTML page type also allows you to code entire pages yourself, completely from 
scratch, without any theming applied by RapidWeaver. Simply select the “Don’t apply 
theme” checkbox and add your HTML code, observing recognized standards.

For your convenience, the HTML page type includes a handy Quick Insert pop-up list of 
frequently used HTML codes that you can insert into your page. Position your cursor at the 
location in your code where you’d like to add an item from the Quick Insert list and then 
select the item. The code will be inserted at the location, ready for further editing.

TIP: You can enter anything into the HTML page type, including Javascript, CSS, PHP and 
more - don't let the name fool you! Remember that the page's extension needs to reflect 
the content on the page, so be sure to check that the Page Inspector has the correct file 
extension in it!

RapidWeaver 3.6.2 Manual v1.0 (2nd August 2007)
 Page 31



iFrame
To display an external site within a page on your own website, select the iFrame page 
style. The iFrame is supported by most modern browsers.

The iFrame page style creates an inline frame that contains another document. For exam-
ple, you could use it to display another website within your own website or perhaps a sup-
port forum.

Once you have entered a URL for the site you'd like to display in your own page, you can 
set the width and height of the frame in which it's displayed as well as the iFrame's border 
attributes.

RapidWeaver 3.6.2 Manual v1.0 (2nd August 2007)
 Page 32



Movie Album
Share your movies with friends, family and co-workers. Simply drag the movies you want 
to publish on your website to the movie list.

You can change the order of your movies by dragging them to the desired position. To 
change a movie’s caption, double-click on the movie’s existing file name or title in the Cap-
tion field. Basic HTML text-formatting tags are supported within the Caption field, if de-
sired.

Tip: Movies should be in QuickTime-supported formats such as .mov, .avi or .mpg.

Album Setup
To give your movie album a title and description, and to set the AutoPlay option, click on 
the "Album Setup" button in the lower part of the screen.

Autoplay Movies
Selecting this option will start the movie automatically when the user opens a movie win-
dow.

Selecting a Thumbnail image
RapidWeaver will automatically select an thumbnail from a point midway through the 
movie because many movies start with a black screen. If you'd like to select the thumbnail 
image from a different position in the movie, double-click on the movie thumbnail in the list 
to bring up the thumbnail selection sheet. Select a frame in the movie you want to use as 
the movie's thumbnail and click the "Set" button.
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Offsite Page
Using an Offsite page style will allow you to redirect visitors to external URL's from a navi-
gation button or link on our website, rather than showing their content inside an iFrame on 
your own site. This is useful if you have a free web board, a friend's website, an affiliate, or 
some other external website to which you want to direct your visitors.

Using the Page Inspector, you can configure the Offsite Page to load the content of the ex-
ternal URL into the current window being browsed by your visitors, replacing the content of 
your own site; or you can load the content of the external site in its own window, preserv-
ing the content of your website in its original window.
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Photo Album
A Photo Album page type allows you to share your personal photos with friends and family 
on your website. The Photo Album includes built-in iPhoto intergration, making it easy to 
share photos from iPhoto. You may also create your own photo albums by dragging and 
dropping photos into a custom Photo Album page.

Using iPhoto Albums
iPhoto albums are listed in the left-hand column. To use one of the iPhoto Albums on your 
website, highlight the desired album in the list. You may add a description about the iPhoto 
album that will displayed on the published page by typing into the album description box 
located below the iPhoto albums list.

When you select an iPhoto album from the list, thumbnails for each photo in the iPhoto al-
bum will appear in the thumbnails list on the right along with its associated file name from 
iPhoto. To arrange the viewing order of your photos, click on a thumbnail and drag it to the 
desired position in the thumbnails list.

By default, all photos will be selected for publishing when you choose an iPhoto album, but 
you can use the checkboxes that precede each thumbnail in the list to select which ones 
should be published on your website. To disable all photos in the list, click the grayed-out 
checkmark at the bottom of the Photo Album page; to select all photos in the list, click the 
solid checkmark.

When published, the selected photos will display the file name of the image as listed in 
iPhoto, but you may replace the file name with a caption of your choosing by typing into in 
the “Caption” field of the selected photo in the thumbnails list.

Below the thumbnails list is a photo preview pane that displays a larger image of the se-
lected thumbnail. You can adjust the size of the previewed image by increasing the size of 
the preview pane. Using your mouse, click on the bar located above the preview pane and 
drag it upwards. As you increase the preview pane’s size, the previewed image will auto-
matically resize itself.

Creating Custom Photo Albums
You may also use photos or images located elsewhere on your hard drive to create a cus-
tom Photo Album page. Begin by clicking into the textbox located above the iPhoto albums 
list and typing a name for your custom album. Once you've chosen a name, simply drag-
and-drop photos from your hard dirve into the thumbnails list, or use the (+) button located 
near the bottom of the window to navigate to the photos on your hard drive. You may ar-
range the viewing order by dragging the thumbnails to the desired position in the thumb-
nails list.

After you’ve added your photos, you can add a description for your custom photo album in 
the album description box located below the iPhoto albums list. As with iPhoto album pho-
tos, the published photos will display their respective file names when published, but you 
may override this by typing new captions in the “Caption” field of any selected photo.
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Page Inspector Setup tab: General

Before publishing your Photo Album page, click the "Setup" button in the lower right corner 
to configure publishing options. When you click the "Setup" button, the Photo Album Setup 
pane in the Page Inspector will appear, defaulting to the "General" tab.

Use Flash Slideshow

This allows you to specify whether to create a pure HTML gallery or a Flash slideshow. If 
you wish to use the Flash slideshow, tick the box and proceed to the Flash Slideshow tab 
to configure it.

Captions
You can specify whether your photos' captions should be displayed below each thumbnail, 
below each full-size photo views, or not at all. To make your selection, choose one of the 
four options in the "Captions" drop-down list.

Thumbnail Size

Use the slider to set the size of the thumbnails to be shown on your Photo Album page. 
Based upon the selected size, RapidWeaver will automatically determine the number of 
thumbnails to be displayed in a row, and the spacing between them. Use smaller thumb-
nail sizes to maximize the number shown per row.

Image Quality

Specify the quality of the photos being published by selecting 'Best', 'High', 'Medium' or 
'Low' from the Compression drop-down list. Higher quality photos will look better, but will 
take longer to download. If you are scaling your photos down from their original sizes, you 
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may also specify whether to use High-Quality Scaling by selecting the indicated checkbox 
to reduce pixelation and other photo-resizing artifacts (recommended).

TIP: For best results, pre-size your photos to the exact dimensions you wish them to be 
viewed on your website using your favorite photo-editing application. Set the Compression 
to 'Best' from the drop-down list and un-check the "Use this size" checkbox in the Image 
Size portion of the General pane. This will result in no compression or resizing of your pho-
tos whatsoever.

Scale Image

By default, photos are constrained to a maximum width of 640 pixels and a maximum 
height of 480 pixels. In other words, your published photos will retain their proportionality, 
but no image will exceed a width of 640 pixels, nor a height of 480 pixels. You can specify 
different maximums by typing in different values. If you uncheck the "Use this size" box, 
RapidWeaver will not constrain your photos at all. Instead, your photos will be published in 
the exact dimensions of your originals, which will increase load times when using large im-
ages.

Navigation
Here you can set the labels for the navigation links in your Photo Album pages.

Visitors to your website can navigate through your photos using the text links on the pub-
lished photo pages. By default, these links are labeled “Previous”, “Home” and “Next”. You 
can customise these links by changing the content of their corresponding fields. This is 
especially useful when publishing your photo album in a language other than English.
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Tab: Flash Slideshow

Slideshow Interface Options

Display - Controls: This will toggle the Flash slideshow’s navigational controls on and off

Display - Info: This will toggle whether to show additional information about each photo

Display - Loading Icon: If you do not wish to show the animated loading icon, untick this 
box.

Activate on Rollover: Choose whether the slideshow should activate when a users 
mouse cursor rolls over the slideshow

Flickr RSS: With RapidWeaver 3.6, you can specify a Flickr RSS feed for photos you wish 
to slideshow. Simply enable this box, and paste in a Flickr RSS feed to show the pictures 
from that feed in the Slideshow.

Slideshow Size: Configure the slideshow size to suit your page’s needs, and specify a 
background colour.

Visual Effects Options

Transition: To choose which transition is used, simply select one from the drop down 
menu, and if required, a transition duration (in seconds) in the box to the right.

Scale Image: Configure the scaling of slideshow images, by choosing to scale the images 
as desired.
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Link to large images: Allows you to specify whether, on clicking a slideshow image, the 
large image should open in a new window.

Image Pause: Set the duration of each image’s appearance on-screen by entering a time 
(in seconds) here.

Ken Burns: The Ken Burns effect (often used in iPhoto slideshows) is available as part of 
the Flash Slideshow. You can turn it on (and specify a type of effect) or turn it off via this 
drop-down.

Variation: This sets the intensity of the zoom within the Ken Burns effect. Dragging to the 
left uses less zoom, whilst dragging to the right will create a more extreme zoom in, as part 
of the Ken Burns effect.
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Tab: Advanced
The "Advanced" tab in the Setup pane in-
cludes options that allow you to manage the 
Photo Album pages photo cache, enable sup-
port for multi-processor Macs and import 
comments from iPhoto.

Photo Cache
Enabling the Photo Cache in RapidWeaver will 
dramatically improve refresh times when 
switching between "Edit" and "Preview" 
modes, and when exporting or publishing your 
website. It is recommended that you leave the 
Photo Cache option enabled. Click the "Clear" 
button to reset your Photo Album page's 
cache.

TIP: If you have previously published or ex-
ported your Photo Album page, and subse-
quently make changes such as disabling, add-
ing or removing photos - or you re-arrange the 
order of your photos in the thumbnails list - you 
may sometimes find that the exported / pub-
lished results aren't what you expected. To cor-
rect this, click the "Clear" button in the Photo 
Cache section and re-export / re-publish your 
Photo Album.

Multi-Processor Support
To speed the processing of your photos when 
being exported by RapidWeaver, owners of multi-processor Macs may enable multi-
processor support by clicking the designated checkbox. Leaving this box checked will not 
result in any processing benefits on single-processor Macs.

Import iPhoto Comments
If you are using an iPhoto album as the source for your Photo Album page and you want to 
use the comments you've created for your photos in the selected iPhoto album, clicking 
the "Import Comments" button in the Advanced pane will retrieve the existing comments. 
Be aware that this will overwrite any custom captions you have created previously.
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QuickTime
Share your movies with friends, family and co-workers. Movies should be in QuickTime-
supported formats such as MOV, AVI or MPEG. To add a movie to the QuickTime page, 
click the "Choose Movie..." button, navigate to the movie you want to use, select it and 
then click the "Open" button.

Add comments or descriptive text by typing in the text box at the bottom of the page. The 
text box supports styled text and all other formatting supported by the Styled Text page.

AutoPlay Movie
Checking the "Autoplay Movie" box will cause the movie to automatically play when a visi-
tor selects the QuickTime page on your website.

Tip: The QuickTime page type has been deprecated and will be removed in future versions 
of RapidWeaver. For pasting individual movies, you may use the Styled Text page type 
which supports more features and functionality than the QuickTime page does.
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Style Text
The Styled Text page type is the most widely-used page style in RapidWeaver. A Styled 
Text page allows you to quickly create a page with styled text, images and movies without 
requiring any knowledge of HTML. However, you may also use HTML to extend the capa-
bilities of the page, if desired. Use the Format menu to apply font and style changes to 
your selected text, or to apply commonly-used HTML options. To add an image, file or 
movie, simply drag it from the Finder into the content area.

The content area of of the Styled Text page type supports the following:

• Text (Styled & Plain)

• Images (PNG, GIF or JPEG)

• Movies (QuickTime, Quicktime VR)

• Files (.zip, .pdf, .sit, etc...)

Styling text
You can style your text by using the Format menu located in the menu bar. If you've used a 
word processor or TextEdit, then styling text in RapidWeaver should already be familiar to 
you. Type or paste your content into your page under the Edit tab, select the desired text 
with your mouse, and choose the appropriate formatting options from the Format menu.
Using the options found under the Format menu, you are able to control the appearance of 
the content on your pages. RapidWeaver offers only those fonts considered to be "web 
safe" and thus viewable on an major OS platform.

TIP: RapidWeaver actually applies a list of fonts to the text you are styling, so you can be 
sure that if a visitor doesn't have the same font installed, the next most-similar font avail-
able in the list will be used. For example, should you use Arial for your text, RapidWeaver 
will apply the following font list: "Arial, Verdana, Helvetica, Sans-serif". If the visitor doesn't 
have the primary font installed (Arial, in this case), then the list tells the visitor's browser to 
use the next available font in the list.

Adding images
To add an image to your page, drag it from the Finder into the desired location in the con-
tent area. Supported image file formats are PNG, GIF or JPEG. Other image file formats 
will appear as embedded links in the published page.

TIP: If you wish to include a PNG, GIF or JPEG image as an embedded link, add it to the 
Pages Assets and create a link to it using the "Add Link" button. For more information 
about adding a link to your text see Adding links to text and images later in this section.

Images that have been added to a Styled Text page may be further refined by using the 
Media Inspector, allowing you to scale the image, rotate it, add a border or shadow effects 
and more. To add a link to an image, see Adding URLs to text and images later in this sec-
tion.

(ctd)
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Adding movies
To add a QuickTime movie to your page, drag it from the Finder to the desired location in 
the content area. A dialog box will appear asking “Do you really want to copy the contents 
of the dragged items into the text?”, and displaying three buttons: Alias, Copy and Cancel.

Clicking the "Alias" button causes RapidWeaver to link to the QuickTime movie file exter-
nally on your hard drive. This results in a smaller project file, but if the movie is subse-
quently moved to another location on your hard drive - or deleted altogether - the link to 
the movie will be broken the next time you open your project file. If you intend to alias your 
QuickTime movies in your Styled Text pages, consider creating a permanent location on 
your hard drive for your website's source files, and add your QuickTime movies to your 
Styled Text page by dragging them from that location.

TIP: There are other advantages to aliasing your QuickTime movies. For example, if you 
choose to edit the movie after you've published your website, you can revise the movie in-
dependently. As long as the revised version resides in the same location on your hard 
drive as the original and retains the same name, the new movie will be used the next time 
you change the page that contains it (or you've marked the page as "Changed").

Clicking the "Copy" button causes your QuickTime movie file to be copied directly into your 
Styled Text page. This will result in a larger project file, but if you move the original movie 
to another location, it will not affect subsequent uploads of your website.

NOTE: Only QuickTime movies may be added to Styled Text pages as described above, 
and will be automatically centered on the page. Other movie formats may be added using 
an HTML <embed>? tag.

Making text flow around images
After placing an image at the beginning of the text you want flowed along its side, highlight 
the image and select "Align Image Left" or "Align Image Right" from the Format > HTML 
flyout menu. Click the Preview tab to see how the text flows around your image and adjust 
as necessary. You may also flow text around an image using these CSS <div class> tags:

<div class="image-left">Place Image Here</div>

<div class="image-right">Place Image Here</div>

Adding links to text and images
To add an email address or URL to text or an image, highlight it and press the "Add Link" 
button at the lower part of the screen.

A dialog box will appear allowing you to either select another page in your RapidWeaver 
project to which the text or image should be linked, or to specify an email address or URL 
of a page on another site. If you have added an item in the Page Assets, you will also be 
able to link to an asset in the list. Once you’ve selected the target of the link, you may 
specify whether the linked item should open in the current window, or to load in its own 
window.

Adding file downloads
Drag and drop a file such as a PDF, ZIP, DOC or other file type to the desired location of 
the content area to automatically create a link to it in your published page. Visitors will be 
able to click the link and download it.

 
 
 
 
 
 
 
 
 (ctd)
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Mixing HTML or Javascript with styled text
You can include HTML or Javascript code in a Styled Text page, but unless you mark the 
block of code properly, RapidWeaver will not render it correctly. To mark a block of code so 
that RapidWeaver will process it correctly, select the block and choose "Ignore Format-
ting" from the Format menu.

You may also use the items in the Format -> HTML flyout menu to apply commonly-used 
HTML formatting options.

Highlight the desired text or object and select the desired item from the HTML flyout menu 
to apply it. For example to cause RapidWeaver to flow text along the right side of an image 
you’ve pasted in the content area, select the image and choose “Align Image Left”. Or to 
make a portion of text stand out, select the text and choose “Blockquote” from the HTML 
flyout menu.

Pasting text
Text copied from another text editor or word processor may be pasted directly into a Styled 
Text page, but such text may include fonts or formatting that aren't web-safe. The pasted 
text will look fine when viewed on your computer, but when viewed by other visitors who 
come to your site, the pasted text may not remder cleanly.

To avoid this when using text copied from another document, hold down the Option key 
and select "Paste as Plain Text" from the Edit menu (or simply paste the text using 
Option-Command-V) . The copied text will be inserted as plain text, which can then be 
formatted as needed using the formatting tools within RapidWeaver.
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Publishing
RapidWeaver allows you to publish your site locally, to a .Mac account or to a webserver. It 
also allows you to publish and export just the pages that have been updated. If you don't 
have a .Mac account you can sign up for one at Apple's .Mac website.

TIP: Hold down the "Option" key when pressing the "Publish" button to force all pages to 
be re-published.

Press the “Publish” button (Command-Shift-E), located at the bottom right-hand corner of 
RapidWeaver’s main window, to bring up the publishing settings. 

Publishing via FTP
RapidWeaver allows you to publish sites directly to a webserver using the built-in FTP (File 
Transfer Protocol) client.

To publish your site using FTP, you will need to provide four things: the server’s URL or IP 
address, your account’s Username and Password, and your webserver’s Site Path (direc-
tory) to which you must publish your website’s contents. If you are uncertain about any of 
these points, contact your hosting provider before you attempt to publish your site.

• Server: The name or IP address of your webserver. The name is often the domain name 
of your website (e.g., 'MyDomain.com'), but may also be an explicit server name pro-
vided to you by your webhost. This varies from one webhost to the next, so check with 
your hosting provider.

• User Name: This is the username required by your webhost to log into your web publish-
ing account.
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• Password: This is the password required by your webhost to log into your web publish-
ing account.

• Save in Keychain: Check this box if you want your Mac to securely remember your 
login password automatically.

• Site Path: This is the path to your website's publishing directory on the webserver. This 
varies from one webhost to the next, but commonly-used site paths include "/", "/www/", 
and "/public_html/" (without quotes). If you are unsure, contact your webhost or ask on 
the RapidWeaver forum.

• Use SFTP: Select this option ONLY if your webserver requires SFTP transfers. When 
selected, the "Advanced..." button is enabled, allowing you to use public/private key pairs 
to effect SFTP transfers discussed later in this section).

• Passive Mode: Selected by default, most webservers use the 'PASV' transfer option. 
Deselect this option only if your webserver requires active file transfer.

• Log in Anonymously: Whilst rarely used, selecting this option will tell RapidWeaver to 
attempt to log into your webserver without a username or password.

Publishing with .Mac

RapidWeaver includes built-in support to publish to your RapidWeaver website on your ex-
isting account on .Mac. If you already have .Mac setup correctly in the System Prefer-
ences, RapidWeaver will automatically use these as defaults when publishing.

• User Name: If you are not using your .Mac System Preferences settings, type your .Mac 
Username in this field.

• Password: If you are not using your .Mac System Preferences settings, this is the 
password required by .Mac to log into your account.

• Site Path: This is the directory to which you are publishing your website on your .Mac 
account.

• Use Default Account: Selecting this option tells RapidWeaver to use the login creden-
tials stored in your .Mac System Preferences, overriding the User Name and Password 
fields entered on this pane.

• Publish to subfolder of Sites Folder: Selected by default, this allows you to publish to 
a subdirectory of your Sites folder in your .Mac account. For example, specifying 'My 
Website' in the Site Path will cause RapidWeaver to publish to a path 
http://homepage.mac.com/YOUR_ACCOUNT/My%20Website. If not selected, Rapid-
Weaver will publish directly to your "Sites" directory on your .Mac account.

• Delete Current Site First: If selected, RapidWeaver will completely erase the contents 
of any existing site found in the Site Path, or in .Mac's "Sites" directory, depending on the 
"Use Default Account" settings chosen.
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Preferences
You can access the Preferences window from the RapidWeaver menu.

General
General options can be changed here. 

Publishing
Here you can find preferences that affect your publishing from RapidWeaver in general. If 
you are experiencing issues publishing, we recommend you try unchecking the “Use 
NcFTP Framework option” and attempt to re-upload the site.

Updating RapidWeaver
RapidWeaver has an auto update mechanism built-in.

Check for Updates...
To update RapidWeaver or to check for updates use the “Check for Updates” option from 
the RapidWeaver menu.

RapidWeaver > Check for Updates...
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RapidWeaver Add-ons
RapidWeaver has a very powerful and open architecture. The current count of Rapid-
Weaver add-ons is 11 plugins, 19 theme developers, 3 applications and many supporting 
web services.

Installing Add-ons
All RapidWeaver add-ons are stored in the RapidWeavers support folder. This is located 
here: ~/Library/Application Support/RapidWeaver/

To install an add-on, drag it into the corresponding support folder:

Setup Items

Plugin .rwplugin ~/Library/Application Support/RapidWeaver/Plugins

Themes .rwtheme ~/Library/Application Support/RapidWeaver/Themes

Theme Styles .rwstyle ~/Library/Application Support/RapidWeaver/Theme Styles

Snippets rwsnippet ~/Library/Application Support/RapidWeaver/Snippets

Caution: RapidWeaver should not be running when installing new add-ons.

Note: The official themes and plugins that ship with RapidWeaver stored in the app bun-
dle.

Plugins
Plugins add additional page styles and functionality to RapidWeaver.

Themes
The list of theme companies is constantly growing, this means you get to choose from 
hundreds of extra themes. Visit each theme site and find the perfect design! Realmac 
Software does not offer support for 3rd party themes, please contact each company for 
support. Below is a list of theme developers.

Theme Styles
Theme Styles are ways of grouping selected Theme Variations. Themes can ship with 
Theme Styles built in

Snippets
Snippets are a new feature in 3.6 that allow you store portions of code (perhaps that you 
use frequently).
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Resources
We recommend you take a look at the following Websites and Resources to get the most 
out of RapidWeaver,

Official Websites
Take a look at the official websites to to get the most out of RapidWeaver.

Support Forum
http://www.realmacsoftware.com/support

Video Tutorials
http://www.realmacsoftware.com/tour/

Site Showcase
http://www.realmacsoftware.com/rapidweaver/showcase

Add-ons
http://www.realmacsoftware.com/addons

3rd Party Websites
Take a look at the following 3rd party websites to get the most out of RapidWeaver.

Screencasts Online
http://www.screencastsonline.com/
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Cheat sheets
Learn all of the Keyboard shortcuts get the most out of RapidWeaver.

Window Keyboard Shortcuts

Main Window (New Document) Command-N

Page Inspector Command-Shift-I (i)

Themes Command-Alt-T

Site Setup Command-1

Media Inspector Command-2

iMedia Browser Command-4

Snippets Window Command-5

Help Command-?

General Keyboard Shortcuts

Add Page... Command-Alt-N

Replace Page... Command-Alt-R

Duplicate Page Command-D

Switch to Edit / Preview Mode Command-R

Advanced Keyboard Shortcuts

Mark All Pages as Changed... Command-Shift-M

Mark All Pages as Unchanged... Command-Shift-Alt-M

Clear Formatting (from a selection of text) Command-Alt-. (Period)

Show Source Code (Not Editable) Command-Alt-U

Reload Page Command-Shift-R
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Thanks for reading.
If you have any comments or feedback on this manual, please email: 
support.ninjas@realmacsoftware.com

Realmac Software would like to thank David Tobin for his invaluable help proof-reading 
this manual.
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